The object of this tutorial
is to build a solid object
using a number of
graphical techniques,
then to mesh it and
solve, and finally to
display the solution.
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Start by opening the Home folder using the

desktop icon. Create a new folder using:
mtsiy Edit > Create New > CalcFiles

+ EEELEE Open Salome-Meca using the desktop

8l +omni0RB: Warn
Jlthis server's

4 teseelaeil icon. Click File > New then select the

found in 2.0

- RIEREls Geometry module from the drop-down box.

own element "c

/| Session Edit V

Ml this server.

Fontconfig warning: line 33:
Fontconfig warning: "/etc/font]
3llh target "scan"
Fontconfig warning: “/e
| cachedir”
“‘{?ﬁa =l Fontconfig warning: "/etc/font]
cachedir"
++omniORB: Warning: the local
il this server's address. Only cl
: Mellthis server.
A + found in 3.0 seconds
Lt Start SALOME, elapsed time :
-~ additional external python int|
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Location Edit View Go Bookmarks Tools
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- OO . 4 : Python 2.3.5 (#1, Sep 4 2005, 22:00:45)
2, 8 ) ] . | [GCC 3.3.5 (Debian 1:3.3.5-13)] on linux2
“ |type help to get general information on environment
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iD@HX|mE ecmey | g@ @B Rwmis /T OLAN/ AR 00000 BN IR SN " wa%Ti08 0%
et Bronzer | £,0CC scene;l -viewer]
Object Value _-: ; ? g . @
L-4gGeometry GEOM B @'Qﬁi o A Q|® |"|f'
-+ Vertex 1
+ Vertex_2
L. Vertex_3

This step creates the points which
will be used later to create other
objects.

- Point Construction

—Points
& e o e

—Result name

Name |\.-'erte)<_4

—Coordinates

Xi [75 =
Y: o 2
Z: 29 2

ok | Apply Close Help |
A

Create points or vertices
New Entity > Basic > Point
vertex 1 0 0 O Apply

window, as it vertex 2 25 0 75 Apply

won’t be used in vertex 3 25 100 75 Apply
this tutorial. vertex 4 0 100 O Apply

T vertex 5 -75 25 OK

You can close
the python
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' b 00000 BEDD 9RBM 0% 08 %%

New Entity > Basic > Vector
vector 1 vertex 1 vertex 5 OK

+ Vector Construction

Result name
Name [Vector_1
Points

Point1 | |Vertex_1

WEe'll be creating an object which
Is inclined to the XYZ axes, so
this step creates the vector for its
direction.
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Vb 00000 BEBDD PRKL0 0% 2i0B | A%

New Entity > Basic > Plane
plane_1 vertex 1 vector 1 OK

Or plane_1 vertex 1 vertex 2 vertex 3 OK (shown)
I

r Plane Construction

C gy F o C &
Result name
Name [Plane_1

3 points

Point 1 Vertex_1

Point 2 ﬂ Vertex :

Here we create a plane
perpendicular to the vector.
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New Entity > Basic > Line
line_ 1 vertex 1 vertex 2 Apply
line 2 vertex 2 vertex 3 Apply
line_ 3 vertex 3 vertex 4 Apply
line 4 vertex 4 vertex 1 OK

Result name
Name |Line_4

Points
Point 1 & | [Vertex 5
Point2 & | |Vertex_1

Apply Close Help
4

Here we create 4 lines which will
make a closed shape ...
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iD@HX |[RE{@Ceomety | g @ Emrmis /T OHAN, AdE 00000 BEDD IR0 %288 L8

= QCC scene:l -wviewernl

1.4 Geometry GEOM
-+ Vertex_1

v New Entity > Build > Wire
; wire_1 selectline_1 ctrl-hold line_2, line_3, line_ 4 OK
New Entity > Build > Face
face. 1 wire. 1 OK
Or New Entity > Build > Face
face_1 selectline_1 ctrl-hold line_2, line_3, line 4 OK (shown)

= | T : =
i s w2y B

I ! ]
- Create A Face = = ,."' ,u"l A

—Face

3

—Result name

Name |Face_1

—Face creation from wires and/or edges
Objects & |4_objects

¥ Try to create a planar face

Apply Close | Help

... then we create a wire from 4
lines, then a face from the wire.

Python 2.3.5 (#1, Sep 4 2005, 22:00:45)
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05 X %2 8 Geoney 3| 0 & © 5 i ' hAF 00000 BEDL @RAM %% Tl

2.0CCscene:l -viewen]

GEOM

New Entity > Generation > Extrusion
extrusion_1 face_1 vector 1 100 OK 2. Construction by Extrusion

Extrusion

=) C &

Result name
Neme [Btrusion 1

Base Shape + Vector

1 Base ﬂ Face_1
e Vector \ector 1

/ Height : 100 2 I Reverse

! [~ Both Directions

e

From the face we’ve built, we can
extrude it in the direction of our &
vector to create a solid object.

~ | Python 2.3.5 (#1, Sep 4 2005, 22:00:45)
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| type help to get general information on environment
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Operations > Transformation > Translation

translation_1 extrusion 1 0 -25 50 create copy yes OK
Select translation_1

right click and select Show only

The solid object isn’t in the right
place, so we move it by specifying
translation distances in x, y and z.

Result name
Name [Translation_1

Arguments

Objects & Extrusion_1

Dix :

Dy &
Dz

o
o
4

1
w
4 4

¥ Create a copy

ok Apply Close Help
|
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Object ar—

“s=n = New Entity > Primitives > Box
i select dx dy dz option
| e 100 100 125 OK
."ieT | Operations > Boolean > Cut
Jws | ocut_ 1 box_1 translation_1 OK
ey Select cut_1
+ S right click and select Show only

+ BOOLEAN : Cut Of Two Objects

—Cut
@

—Result name

MName |Cut_1

—Arguments
Main Object A |Box_1
Tool Object & |E)¢rusion_1

ok | apply | cClose Help |

We create a box, then cut from it
the object we created previously.
Selecting Show only we see the

resulting solid object ...

Python 2.3.5 (#1, Sep 4 2005, 22:00:45)
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DEAX mE (R e s et tami S 0bAN 40K 00000 BBDD YRR St tIB M

ObJec;: Ivalue |
2.4 Geometry GEOM
-+ Vertex_1
-+ Wertex 2
iy New Entity > Basic > Vector
gy vector 2 vertex 1 vertex 4 OK
-~ Line_1 . . .
3 /tne2 New Entity > Basic > Point

4 Une 3 vertex 6 50 -25 65 OK

-~ Line_4

paFace 1 New Entity > Primitives > Cylinder

- @ Extrusion_1

- @Box 1 cylinder_1 vertex 6 vector 2

- g Cut_1

R etor 2 Radius 25 Height 150 OK

p,“ﬁ‘i@ﬁ'ﬂl ¥ By | B |

+ Cylinder Construction

—Cylinder
8 ce

—Result name

Name |Cy|inder_1

—Arguments

Base Point A | |Vertex &

Vector ﬂ |vector_2
Radius : |25 il
=

Height : [150]

ok | apply Close Help |

. as shown here. Next we create
a new vector to define the axis of
a hole we want to bore through
the solid, a point which defines its
| position, and the cylinder itself.

Python 2.3.5 (#1, Sep 4 2005, 22:00:45)
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Object Ivalue |
-4 Geometry GEOM
-+ Vertex_1
-+ Wertex 2
-+ Vertex_3
-+ Vertex_4

+- .~ Vector_1

+- @Plane_1

#- . Line_1

- Line_2

-+ Vertex_5
-~ Line_3

# . Line_4

- @Face_1

+- @ Extrusion_1

L $ DY E N B

- @Box_1

sacut] After cutting the hole from the

-+ Vertex 6

+ Vector 2 solid, we can display only the
- @ Cylinder_1 .
result, and shade it.

Operations > Boolean > Cut
cut 2 cut 1 cylinder 1 OK
Select cut_2
right click and select Show only
View > Display mode > Shading

Python 2.3.5 (#1, Sep 4 2005, 22:00:45)
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Object Ivalue |

-4 Geometry GEOM @ &&@ v @ & &
-+ Vertex_1
-+ Wertex 2

vees | In this step we begin to define the
+- .~ Vector_1 .
Lerane 1 | faces on which we want to put

[#- .~ Line_1

+line_2 loads and constraints. First, select

-+ Vertex 5

~wes | New Entity then Explode. Choose

[ Line_4

rseel | the object Cut 2 and select Face.

[+ @ Extrusion_1
- @Box_1 OK
+- g Cut_1 "

-+ Vertex_6 |

% || 4

+- .~ Vector_2
s'_s--leIlnder 1

Expand Cut 2.

+ Sub Shapes Selection

~Sub Shapes
& &

—Arguments
Main Object & | |cut 2

Sub Shapes Type :

 Select Sub Shapes

ok | apply Close Help |

Python 2.3.5 (#1, Sep 4 2005, 22:00:45)
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Object Ivalue |
1.4 Geometry GEOM
-+ Vertex_1
-+ Vertex_2
-+ Vertex_3
-+ Vertex_4
#- . Vector_1
+- @Plane_1
#- . Line_1
- Line_2
-+ Vertex_5
oo e~ You can select faces individually,
L. | but this method explodes all
- @ Box 1 . .
L e faces. Select Face 6, right click
-+ Vertex 6

- veoz | @nd rename it BaseFix for easy

- @ Cylinder_1

ecut 2 recognition later. Similarly,

e Cut_l

~onect | rename Face_9 as LoadFace.
ol
- @ Face_5

z,0CC sceneil cviewen]

fwm e 2HD YR R

+ _Rename

. @mFace_7
- @ Face_8

-~ @ LoadFace
+-@Face_10

This completes the geometric
construction. You could save the work so
far using File, Save As, then navigating to
your Home/CalcFiles folder.

Python 2.3.5 (#1, Sep 4 2005, 22:00:45)
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Now select the Mesh module. The
display window and the icons will

change. Select Mesh then Create
Mesh. Select Cut 2 as the object.

+ Create mesh

w3 ay e
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D@l X | By @ {@Mesh ]| @ & '@ 52 e e 4 & 4 408805 5 W P AT P rP PP AP RAE Y- NV ENAR® Y
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i. 2 : =|[7OCC scene:2 -viewer:1 \II¢.sce lewer:
bjec alue 1 & : ;
T e s 28Dy A L QED
-+ Vertex_1
-+ Vertex_2
e
weei | Press the Assign a set of
o hypotheses button, then select
-+ Vertex 5 . . B .
7L Automatic Tetrahedralisation. This
=1 | @ssigns a set of default
B parameters for meshing. Cancel
e | the dialog box shown in the

+ @ Cylinder_1

% Ut 1
-* Cylinder_1
- @ Face_2
-@Face_3
-mFace_4
-@Face_5
- @ BaseFix
-@Face_7
-m@Face_8
+- @ LoadFace
im Face_10
-§EMesh

picture.

|| ¢#% Automatic Length
_'fw_ Arguments
Name [automatic length_1

Fineness 0 _|———— 1

OK | cancel | Help
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DX | B
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| &% Mesh
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| e S e i scene l s viewenly|

Object

Value W e oy WA i

.45 Geometry
-+ Vertex_ 1
-+ Vertex_2
-+ Vertex_3
-+ Vertex_4
- Vector_1
-@Plane_1

- Line_1

- Line_2

-+ Vertex 5
- Line_3

- Line_4
-@Face_1

- @Box_1
g Cut_1

-+ Vertex_6
-~ Vector 2

- CUE 1

-§EMesh

GECM

- @ Extrusion_1

+ @ Cylinder_1

After selecting the 1D tab, press the
button to the right of the Hypothesis
drop-down box. Select Nb. Segments
and choose 10 segments. Press the
button to the right of the
Add.Hypothesis drop-down box and
choose Quadratic Mesh.

-* Cylinder_1
-mFace_2
-mFace_3

- @ Face_4
-mFace_5

- @ BaseFix
-@Face_7
-mFace_8

+- @ LoadFace
iom Face_10

Geometry & l!Cut_z

Algorithm | Wire discretisation LI

=1 2 4
=1 3| o
Assign a set of hypotheses |

Hypothesis [Nb. Segments_1

Add. Hypothesis | Quadratic Mesh_1

Apply | Close | Help
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D&M X | &Mesh o @aes 2w @eHdAE8REVAEA* wyrPYrw PP AP PRIY S - "V UENAHS T I
R BB FomE §
T T — : = e? - 4 (11 f
Object Walue - B F ——
.45 Geometry GEOM & G 'Ov ‘T’v@’ L= Loogfilat ﬁ
-+ Vertex_1
-+ Vertex 2
-+ Vertex_3
- Vertex_4 = Mesh computation succeed
. Vector 1 o DI DL E
mPlare. 1 —Compute mesh
Line_1 g
-~ Line_2 S
-+ Vertex 5
~Line_3 Mesh
- Line_4 —Mesh Infos
-mFace_1 Total Linear Quadratic
- @ Extrusion_1 Modes : 15237
- @Box_1
-gCut 1 Edges : 220 0 220
-+ Vertex_6 Faces : 3106 (o]
s VECtOr:2 Triangles : 3106 o}
?:?ﬂnser—l Quadrangles; 0 0
et 1 Polygons : 0
-* Cylinder_1 Volumes : 8988 0]
- @ Face_2 Tetrahedrons : B988 0
-EFace_3 Hexahedrons : 0 0
-mFace_4 Pyramids : 0 o}
: 2 ;ZCSZ_F?X Prisms : 0 o}
focines Polyhedrons: O
-@Face_8
+- @ LoadFace
iom Face_10 ‘
--EzMesh
+- ¥ Hypotheses 1 1
e Right-click over Mesh 1 and

Cut 2

£ Applied hypotheses

ok Nb, Segments_1

* Quadratic Mesh_1

! * Length From Edges (2]
i--g Applied algorithms

L% Regular_1D

i-* MEFISTO_2D

t.* Tetrahedron (Netgen)

select Compute. When the mesh
is calculated a summary box will
appear. Press OK. At this stage

you may wish to save another
copy of the work.
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Y, i A1 Ls

DEFEX |BE st C@dekEwm~: ] 0000 HE
r - =

Object

T
Value

{1k SCe

2.4 Geometry

-+ Vertex_1
-+ Vertex 2
-+ Vertex_3
-+ Vertex_4
i~ Vector_1
0o Plane_1

- Line_1

- Line_2

-+ Vertex_5
-~ Line_3

i~ Line_4
i-mFace 1

- @ Extrusion_1
----ﬁJBOX_l
-$Cut_1

-+ Vertex_6
i~ Vector_2
é--ﬂJCyIinder_l

Ot 1

-* Cylinder_1
- @ Face_2

+- @ Face_3
i@ Face 4
-@Face_5

+- @ BaseFix
i-mFace 7
-@Face_8

GECM

SalomePbject Choice

aw AEDYA Y DEH

Select a main shape from the Salome Object

Browser

Cut 2

2|

< Back

Mext =

Cancel

+- @ LoadFace
4.mFace_10
--EsMesh
- § Hypotheses
+ £ Algorithms
SMesh 1
+ Cut 2
—: Applied hypothes
. L*Nb. Segments |
Quadratic Mes
i =*Llength From E
i--g Applied algorithm
¥ Regular_1D
L MEFISTO_2D
L% Tetrahedron (M

Now select the Aster module. The

display window and the icons will
change. Press Code Aster Wizards

and select Linear Elasticity > 3D >

Geometry. Select Cut 2 as the object
then Next>. You will be asked for
Young’s Modulus and Poisson’s

Ratio, then Next> again.
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N @EHEX | BE jmhster ] @@e B Ll ] 6 QOO TS

Py, f, fr 4e

Object

T
Value

e @W@,}:@L@

2.4 Geometry
-+ Vertex_1
-+ Vertex 2
-+ Vertex_3
-+ Vertex_4
i~ Vector_1
0o Plane_1
- Line_1
- Line_2
-+ Vertex_5
-~ Line_3
i~ Line_4
i-mFace 1
- @ Extrusion_1
@BOX_I
-$Cut_1
-+ Vertex_6
i~ Vector_2
@--@Cylinder_l
N 5 C ut 2
=% Cut_1
-* Cylinder_1
-@Face_2
i~ @ Face_3
i@ Face 4
-@Face_5
+- @ BaseFix
i-mFace 7
-@Face_8
+- @ LoadFace
4.mFace_10
--EsMesh

- § Hypotheses

»ff--gﬂ.lgorithms

SMesh 1

+ Cat 2

—: Applied hypotheses

_Zusotropic Linear Elastic Study

Imposed Degrees of Freedom

Choose the Entities and the DoF to be imposed

'object bx Dy DZ
== | Sasefix ~llo o (o]

In this case we want to
completely constrain the bottom
face. Select BaseFix and set DX,
DY and DZ to zero. Press Next>
then select LoadFace and enter
the applied pressure (say 100 N/

Help

*MNb. Segments_1
* Quadratic Mesh_1

¢ ¥ Length From Edges (2D Hyp. for Tria...

i--g Applied algorithms
¥ Regular_1D
L MEFISTO_2D
L.* Tetrahedron (MNetgen)

mm2). Further steps in this
dialog box ask for a file name
and confirmation of the mesh.
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DEH X% | @Post-Pro || @ & & &=

Y Y T L L T N T

- o __SCeEne’L -viewer:'1l [T = ’ M.
Object Value R B & @ n@ o I.@ !'igg ﬁ:
§-4&Geometry GEOM =Cose L=
+-FpMesh SMESH
- meASter ASTER

+- iz |AsterFiles
| | glinearStatics_3DMesh_1(OK)
- @gPost-Fro
4-linearStatics_3DMesh_1.resu.med
L.MAIL
+#-Families
+-Groups
3.Fields
5.RESU__ DEPL
| *onhodes
¢ 2.0, INCONNUE
& Z/Def.Shape
#-RESU___EQUI_NOEU_SIGM
i--RESU_SIGM_NOEU_DEPL

After the dialog box
closes an Aster line will
appear. Expand it and
right click the line
beginning LinearStatics
and then select Solve.

A successful solution will
result in a Post-Pro line
followed by a tree. Follow
down to Fields and open
the first group. This group
contains deflections. Right
click over 0, Inconnue and
select Deformed Shape.

-0.0200

To view properly, right click over Def.Shape and select Show only. By right
clicking over the object in the display window, or right clicking over Def.Shape
again and selecting Edit, you can look at the object in many different ways.

-0.1000
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Select the second group and
right click over 0, Inconnue. This
group contains von Mises
criteria, etc. Right click and
select ScalarMap.
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 OCC SCENe 2 TVIEWer 1 [man e T VI T eem

D& H X | [@PostPro ~[| @ & @ ¥ = e re i o RN P 4D 1 P G L2 -0
| T =
Object Value 5 .
: C T U 6 TR T c @l Wy Al
-4 Geometry GEOM L&D 0 E FOED
i SMESH
ASTER

+- _gplinearStatics_3DMesh_1(0K)
Z-g@Post-Pro
4-linearStatics_3DMesh_1.resu.med
L-MAIL
+-Families
@--Groups
3.Fields
L.RESU__ DEPL
-* onNodes
5.0, INCONNUE

i-RESU___EQUI_NOEU_SIGM
L4 oniodes
5.0, INCONNUE

L@@ ScalarMap
5.RESU___ SIGM_NOEU_DEPL
-* onhodes
5.0, INCONNUE

{847/ ScalarMap: 1

Select the third group and right

click over 0, Inconnue. This

group contains st

click and select ScalarMap.

resses. Right

™ :Build presentation on

groups

|

]

—Scalar range

Scalar Mode | [3]SIZZ, -
I" Logarithmic scaling

 Use field range

|

 Use imposed range

Min: [-400

Max: [100

~Colors and labels

Nb. of colors: |10 4] Nb. of labels: [6 =
—Orientation

& Vertical  Horizontal

-0Origin

X: [0.01 2 ¥: Jo.o1 =
—Dimensions

width: [0.05 2| Height: [o5 =

™ Save as default values

[~ Show preview

Text properties... |

L 1

N A |

PP EBD




